
© Copyright 2012 Sensors & Software Inc.                                                  Drawing Number:  2006-00112-05









SENSORS & SOFTWARE INC. PRODUCT LICENCE, COPYRIGHT, LIABILITY AND WARRANTY INFORMATION

Important
Please read this document carefully before removing the SOFTWARE PRODUCT storage media from their protective cover
or assembling the HARDWARE PRODUCT. By removing the storage media or assembling the hardware, you are agreeing
to be bound by the terms of this agreement. If you do not agree to the terms of this agreement, promptly contact Sen-
sors & Software, Inc. at the address indicated at the end of this document.

Definition
The word PRODUCT as used herein defines any tangible item sold by Sensors & Software, Inc. and may be comprised
of HARDWARE PRODUCT which consists of physical objects and SOFTWARE PRODUCT which means computer programs,
codes and related support materials.

Software Product Licence Agreement
In order to preserve and protect its rights under the applicable laws, Sensors & Software, Inc. (hereafter S&S) does not
sell any rights to its Software product. Rather, S&S grants the right to use its software, diskettes (or other storage
media) and documentation (hereafter collectively called SOFTWARE PRODUCT) by means of a SOFTWARE PRODUCT
licence. You acknowledge and agree that S&S retains worldwide title and rights to all its software and that the SOFT-
WARE PRODUCT contains proprietary materials protected under copyright, trademark and trade secret laws.

Grant of Software Product Licence
In consideration of payment of the licence fee, which is the price you pay for the SOFTWARE PRODUCT and your agree-
ment to abide by the terms and conditions of this Licence Agreement, S&S grants to you, the Licencee, a non-exclu-
sive right to use the SOFTWARE PRODUCT under the following conditions:

You may:
• use the SOFTWARE PRODUCT on a single workstation owned, leased, or otherwise controlled by you
• copy the SOFTWARE PRODUCT for backup purposes in support of  your use of the product on a single workstation.
You may not:
• copy, distribute, or sell copies of the SOFTWARE PRODUCT or accompanying written materials, including modified or

merged SOFTWARE PRODUCT to others;
• sell, licence, sublicence, assign, or otherwise transfer this licence to anyone without the prior written consent of S&S;
• modify, adapt, translate, decompile, disassemble, or create derivative works based on the SOFTWARE PRODUCT.

Termination
This licence is effective until terminated. You may terminate the licence at any time by returning the SOFTWARE PROD-
UCT and all copies to S&S. The licence will automatically terminate without notice by S&S if you fail to comply with any
terms or conditions of this agreement. Upon termination, you agree to return all copies of the SOFTWARE PRODUCT to
S&S.

Update Policy
S&S may create, from time to time, updated versions of its SOFTWARE PRODUCT. At its option, S&S will make such
updates available to licencees who have paid the update fee.

Product Warranty, Limited Remedy, and Limited Liability 
S&S warrants the PRODUCT to be free from defect in material and workmanship under normal use for a period of one
year (365 days) from the date of shipment. Any third party computer systems or other items not manufactured directly
by S&S purchased with any PRODUCT or independently from S&S are subject to the original manufacturer's warranty
and not the responsibility of S&S.

S&S makes no other warranties including, but not limited to, any implied warranty of merchantability or fitness for a
particular purpose.  If this product is defective within the warranty period stated above, your exclusive remedy shall be,
at S&S’s option, to replace or repair the S&S product or refund the purchase price of the S&S product.  Except where
prohibited by law, S&S will not be liable for any loss or damage arising from this S&S product, whether direct, indirect,
special, incidental, or consequential regardless of the legal theory asserted.



All statements, technical information, and recommendations related to S&S products are based on information
believed to be reliable, but the accuracy or completeness is not guaranteed. Before using this product, you must eval-
uate it and determine if it is suitable for your intended application.  You assume all risks and liability associated with
such use.  Any statements related to the product which are not contained in S&S current publications, or any contrary
statements contained on your purchase order, shall have not force or effect unless expressly agreed upon, in writing,
by an authorized officer of S&S.

S&S warrants the diskettes or other storage media on which the SOFTWARE PRODUCT is furnished to be free from
defects in material and workmanship under normal use for a period of ninety (90) days from the date of purchase as
evidenced by a copy of your invoice.

Except as specified above, any SOFTWARE PRODUCT is provided "as is" without warranty of any kind, either expressed
or implied, including, but not limited to, the use or result of use of the product in terms of correctness, accuracy, reliabil-
ity, currentness, or otherwise. The entire risk as to the results and performance of the PRODUCT is assumed by you. If
the PRODUCT is defective or used improperly, you, and not S&S or its dealers, distributors, agents, or employees,
assume the entire cost of all necessary servicing, repair, or correction.

S&S's entire liability and your exclusive remedy for SOFTWARE PRODUCT shall be, at S&S's option, either

• the replacement of any diskette or hardware components which do not meet S&S's Limited Warranty and which are
returned to S&S postage prepaid with a copy of the receipt,; or,

• if S&S is unable to deliver a replacement diskette which is free of defects in material or workmanship, Licencee may
terminate this agreement and have the licence fee refunded by returning all copies of the SOFTWARE PRODUCT post-
age prepaid with a copy of the receipt.

If failure of any PRODUCT resulted from accident, abuse, or misapplication, S&S shall have no responsibility to replace
the SOFTWARE PRODUCT, refund the licence fee, or replace or repair the HARDWARE PRODUCT.

Do not tamper with any PRODUCT.  PRODUCT contains no user serviceable parts.  If tampering is evident, in S&S’s opin-
ion, warranty is void and null.

No oral or written information or advice given by S&S, its dealers, distributors, agents, or employees shall create a war-
ranty or in any way increase the scope of this warranty and you may not rely on any such information or advice.

Neither S&S nor anyone else who has been involved in the creation, production, or delivery of the PRODUCT shall be
liable for any direct, indirect, special, exemplary, incidental, or consequential damages, claims, or actions including lost
information, lost profits, or other damages arising out of the use or inability to use this PRODUCT even if S&S has been
advised of the possibility of such damages.

This warranty gives you specific rights.  You may have other rights which vary from province to province, territory to ter-
ritory, and certain limitations contained in this limited warranty may not apply to you.

General

pulseEKKO®, Noggin®, SpiView®, Conquest®, RoadMap® and SnowScan® are registered trademarks of S&S. No
right, licence, or interest to such trademarks is granted hereunder with the purchase of the PRODUCT or the SOFTWARE
PRODUCT licence.

Governing Law
In the event of any conflict between any provision in this licence agreement and limited warranty and any applicable
provincial legislation, the applicable provincial legislation takes precedence over the contravening provision. This
agreement shall be governed and construed in accordance with the laws of the Province of Ontario, Canada.

Serviceability
Should any term of this agreement be declared void or not enforceable by any court of competent jurisdiction, the
remaining terms shall remain in full effect.

Waiver
Failure of either party to enforce any of its rights in this agreement or take action against any other party in the event of
a breach of this agreement shall not be considered a waiver of the right to subsequent enforcement of its rights or
actions in the event of subsequent breaches by the other party.



Acknowledgement
You acknowledge that you have read this agreement, understand it, and agree to be bound by its terms and conditions.
You further agree that this agreement is the complete and exclusive statement of agreement between the parties and
supersedes all proposals or prior agreements, oral or written, between the parties relating to the subject matter of this
agreement.

Should you have any questions concerning this agreement, please contact in writing:

Sensors & Software Inc.
1040 Stacey Court

Mississauga, Ontario
Canada L4W 2X8
Tel:(905) 624-8909
Fax:(905) 624-9365

Web: www.sensoft.ca 
E-mail: sales@sensoft.ca 

pulseEKKO, Noggin, SpiView, SnowScan, Conquest, SmartCart, SmartHandle, RoadMap, Conquest for Windows, 
ConquestView, Win_EKKO, EKKO_Mapper, EKKO_3D and EKKO_POINTER ARE TRADEMARKS OF SENSORS & SOFT-

WARE INC.
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 1 Overview
Conquest is an integrated ground penetrating radar (GPR) data acquisition platform specifically
designed to meet the needs of the concrete inspection industry. The system consists of the
display unit with the monitor, sensor head, survey grids and AC power supply connections. The
Conquest Enhanced system also includes a remote keypad, handle for the sensor head, a
removable Compact Flash disk and PC software.

Conquest provides quick, easy surveying with integrated analysis and 3D imaging. Conquest
Enhanced provides extended capability of data transfer to a PC and Windows-based software for
further enhancement and image export for reports. 

The PCD (Power Cable Detector) uses an additional sensor built inside the Conquest sensor
head to detect and image current-carrying cables inside or beneath the concrete. The PCD data
are collected at the same time as the GPR data so there is no additional effort required by the
operator.

 Figure 1-1:Picture of the Conquest system in operation.
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 2 Assembling Conquest

2.1 Basic Assembly

Use the following steps to assemble the Conquest unit:

1. Undo the 4 plastic latches that secure the lid of the Conquest carry case and open the 
lid.

 Figure 2-1:The main components of a Conquest system.

2.The LCD monitor is held on a piston-hinged frame that can be raised and lowered to
hold the monitor at any angle for viewing. Gently pull up the edge of the monitor to the
desired angle.

3. The Conquest system will have 3 or 4 cables, depending on options.  These cables
are stored in the deeper storage area under the monitor.  Identify the following cables:

a) System power cable with AC plug

b) LCD power cable with AC plug

c) Yellow cable attached to the Sensor Head

d) Cable to the Remote Receiver (optional)
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 Figure 2-2:Conquest cables.

4.Cables A and B must be plugged into a 110-240 volt AC power source.  If the system is
powered properly, the green LED on the Monitor Keypad will illuminate.  Cables C and
D should already be connected.

5.Figure 2-3 shows all the cables and connections in the back of Conquest system. All
these connections should already in be in place but check to make sure that they are
secure. Also check that the connection to the Sensor Head is tight.

 Figure 2-3:Cable connections in the back of the Conquest system.
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6. Turn on the system by pressing any button on the Monitor Keypad.  Note that this
MUST be done on the Monitor Keypad and not the Sensor Keypad or the Remote
Keypad.  After the system is powered on, the red LED on the Monitor Keypad will be
illuminated.

7. Once the main menu is displayed on the LCD monitor screen, you are ready to begin
scanning with Conquest!

8. Use the Help option (Section 6: P31) from the main menu to learn how to scan and
generate depth slice images.

9. In high dust environments, keep the carry case lid tilted down over the back of the
monitor to minimize the amount of dust settling in ventilation slots.

2.2 Attaching the Handle

Conquest Enhanced comes with a handle to allow the operator to stand up during data collection
on floors.

Retract the spring-loaded knobs on the end of the handle, align with the two holes at the back of
the Sensor Head and release them to lock into position.

 Figure 2-4:Connecting the optional handle to the Sensor Head allows data collection to be performed from 
a standing position.

There is an additional set of handle mounting holes which can be used under unique
circumstances like scanning a vertical surface or in confined spaces when pulling the sensor
head towards the user may be preferable to pushing it.
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 Figure 2-5:The optional handle can also be attached to the Sensor Head using the holes in the front. This 
mounting position can make it easier to scan walls or complete surveys in situations where pulling the Sen-

sor Head is preferable to pushing it.

2.3 Using the Compact Flash

To save data to the optional Compact Flash card, make sure the system is powered down, tilt the
monitor down into its storage position, tilt up the Monitor Keypad and insert the card into the card
slot.  Data are always saved to the internal memory but, when a removable card is present, the
data can be copied to the removable card using the Export function accessible from the Tools
menu.

 Figure 2-6:The Compact Flash card slot is located under the Monitor Keypad. Conquest data can be 
saved to a Compact Flash card and transferred to a PC for plotting and processing.



Conquest 3-Packing Up Conquest

7

 3 Packing Up Conquest
1. After scanning is complete, power down the system with the Power Off option from 

the main menu.

2. Unplug the system and LCD monitor power cables from the AC power supply and
carefully place these cables into the deeper storage area behind the monitor.

3. Place the Sensor Head back into its storage location in the Conquest carry case and
place the cable into the storage area behind the monitor.  Ensure that the part of the
cable closest to the Sensor Head is set into the foam channel cut-out so it is not
damaged when the monitor is lowered into its storage position.

4. Ensure that the optional Remote Receiver Cable runs inside the foam channel cut-out
so it is not damaged when the monitor is lowered into its storage position.

5. Carefully lower the LCD monitor into its storage position and close the lid of the carry
case, securing the 4 plastic latches.

6. The carry case has wheels and an extendable handle so the Conquest system can be
easily transported.  

The Conquest system comes in a strong, weatherproof plastic case with wheels and an
extendable handle for easy transportation. The Conquest system can be carried like a suitcase
using the large handle on the front or pulled upright on the wheels when the extendable handle is
employed. When pulled upright, you must move the tab to pull out or push in the handle. 
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 4 Principles of Operation

The Conquest system uses ground penetrating radar (GPR) technology to image concrete and
other similar materials (soil, rock, asphalt, etc.). GPR systems emit a high frequency radio wave
pulse and detect the echoes that return from within the material. The concept is shown in Figure
4-1.

 Figure 4-1:The Conquest sensor head transmits GPR signals into concrete and collects the signal that 
reflects from rebar, conduits and other targets embedded inside.

The GPR display shows signal amplitude versus depth (time) and sensor position along a line.
This is called a “Line Scan”. The echo sounder and fish finder used on boats operate in an
analogous fashion as indicated in Figure 4-2.

 Figure 4-2:GPR is conceptually similar to a fish finder.

GPR is just like a fish finder &
echo sounder

• sends out a ping
•  signal scattered

back from fish
• signal scattered

back from bottom
• in this example

single record has 2
blips at different
times

The fish finder record

• as the boat moves -
collect recordings

• display the
recordings side by
side

• the result looks
like a cross section
through the water
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4.1 Line Scans Crossing Targets Perpendicularly

Conquest detects rebar and conduits which are generally rod-like in shape. A line scan over a
localized feature such as a pipe or bar crossed perpendicularly generates a hyperbola (inverted
V) as sketched in Figure 4-4. 

The sensor should cross perpendicular to the long axis of the feature, i.e. we must cross the
feature at 90o (Figure 4-3). 

 Figure 4-3:The arrow represents the path of the sensor, crossing the rebar or conduit at 90o.

When the sensor crosses a target, we get the typical “hyperbolic” or inverted “V” response from
the target, as shown in Figure 4-4. A real data image is shown in Figure 4-5.

 Figure 4-4:Crossing a target perpendicularly produces an inverted “V” or hyperbola in the cross-section 
image.
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 Figure 4-5:Data image of a hyperbola produced by crossing a rebar perpendicularly with the sensor.

The point (apex) of the V gives the position and depth of the feature (Figure 4-6). 

 Figure 4-6:The actual location of a target corresponds to the top or apex of the hyperbola.

4.2 Concrete Type

The shape of the hyperbola (Figure 4-4 and Figure 4-5) is controlled by the “Concrete Type”
property, which is a measure of the velocity the Conquest signals travel through the particular
concrete. For reliable depth estimates and accurate depth slice images, the user must calibrate
the unit on each site to extract the concrete type. 

The Concrete Type can be extracted from the data by calibrating after collecting a cross section
data image like Figure 4-5. Crossing the target perpendicularly is important to ensure accurate
Concrete Type calibration.
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4.3 Lines Scans Running Parallel to Targets

Moving parallel to (or directly on top of) the subsurface feature (Figure 4-7) results in a constant
flat line in the data image (Figure 4-9). Other features such as layers and the bottom of concrete
also appear as flat surfaces.

 Figure 4-7:The arrow represents the path of the sensor, running on top of a rebar or conduit.
 Figure 4-8:

 Figure 4-9:Data image of a hyperbolas produced by a line scan crossing a rebar perpendicularly. The 
image also shows flat lines generated by running the sensor parallel along the top of a rebar and the bot-
tom of concrete. Ensure that the Filter option is OFF or flat-lying features are removed from the image.

Be aware that Conquest has the option of applying a background subtraction filter to the data to
remove flat-lying features in the data image. The filter option is available on the Color button in
Line Scan, Grid Scan (see Figure 5-3) or Slice View. The filter is used to enhance the hyperbolas
from targets like rebar so if your interest is a flat-lying feature like the bottom of concrete, make
sure that the Filter is OFF.

Bottom of 
Concrete

Top of Rebar
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4.4 Grid Scan Collection

A Conquest grid scan consists of collecting a series of parallel line scans in two directions
perpendicular to one another (Figure 4-10). 

 Figure 4-10:Grid Scans are based on collecting multiple line scans in two directions on a grid.

Together, these line scans sample a 3D volume or cube of concrete. This is shown conceptually
in Figure 4-11a. Processing the data results in a solid data volume, again, conceptually shown in
Figure 4-11b.

 Figure 4-11:(a) A series of lines scans on a grid cover a volume. (b) Processing interpolates data into the 
gaps between lines to produce a solid volume.

a b
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The data volume can then be visualized as a number of “slabs” or depth slices. Conquest
displays a series of 2.5 cm (1 inch) thick depth slice images moving through the data volume
from top to bottom (Figure 4-12).

 Figure 4-12:The concept of grid scanning with Conquest. Collecting a grid of data results in a data cube or 
3D volume that is visualized as a series of 2.5 cm (1 inch) thick depth slices.

4.5 Limitations

Before using the Conquest system, keep in mind that Conquest won’t solve every problem that
you will face. 

4.5.1 New Concrete

Most importantly, Conquest will not work effectively on very new concrete. When concrete is very
fresh, it absorbs the signals that the Conquest system emits and does not allow penetration to
substantial depths. Depending on the concrete mix and local conditions, curing can take days to
weeks. As a result, the use of Conquest in the early stages of concrete construction has to be
considered experimental until the concrete is adequately cured. 
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4.5.2 Concrete Covered by Metal

In some situations, concrete may be covered by metal or contain a very fine screen mesh. This
can happen in a plastered wall or in a terrazzo floor. In these cases the metal screen acts like a
perfect mirror for the radio signals emitted by the Conquest sensor. All the signals are reflected
back and nothing will penetrate into the subsurface. At such sites, Conquest will not be effective
for subsurface imaging.

4.5.3 Penetration Depth

GPR uses radio waves to image the subsurface. These waves are strongly absorbed by the
material being scanned. The material type and pore water salinity dictate how deep signals will
penetrate. Concrete can be highly variable depending on the original mix and state of wetting.
Figure 4-13 shows how the depth of penetration can vary with concrete type.

 Figure 4-13:Concrete absorbs GPR signals and generally limits penetration to about 18” (0.5 m).

There is a finite limit on the concrete thickness that can be probed. Experience indicates 18” (0.5
m) concrete is the limit of exploration. In some situations where concrete is very dry and optimally
mixed to hydrate all cement, penetration can reach 24” to 36” (0.6 to 1 m) but this is not common.
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4.6 Power Cable Detection (PCD) Principles

The PCD sensor maps the location of current-carrying cables by detecting the magnetic field
created by AC current flowing at 50 Hz or 60 Hz. 

 Figure 4-14:Depiction of the magnetic field created by a current flowing in a wire.

 Figure 4-15:The Conquest detects the current-carrying cable best when crossing it perpendicularly.
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 Figure 4-16:In Line Scan mode, the PCD profile appears under the GPR cross-section image. The PCD 
profile also appears after collecting each line in a Grid Scan.

 Figure 4-17:After Grid Scan data have been processed into depth slice images, the PCD image can also 
be displayed.

The magnetic field generated by current flowing in wires can be simple or highly contorted
depending on how the wires are oriented.  Examples of simple and twisted wires are shown in
Figure 4-18.
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 Figure 4-18:The shape of the magnetic field generated can be simple or complex depending on whether 
the wires are straight, vertically or horizontally oriented, their spacing and the dgree of twist.
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The amplitude of the PCD responses depends on the amount of current, cable depth, wire
separation distance and degree of twist.  The PCD response can vary over a wide range,
typically from double digits to 10,000 or more (Figure 4-19). 

 Figure 4-19:The strength of the magnetic field generated depends on the nature of the wire: single wire, 
pair or twisted pair and the spacing.  It also depends on the depth of the wire and amount of current flowing 

in the wire.  PCD values can vary over a wide range depending on these factors. 
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 5 Line Scans and Grid Scans

Your Conquest system is designed to make images of concrete structures at various depths.
Embedded features are revealed as layers (or depth slices) of concrete are stripped away. 

Given the limitations mentioned in Section 4.5: P14, most sites are quite amenable to Conquest
measurements. The following is a simplified step-by-step approach that one should use to
investigate a site using your Conquest system.

5.1 Step 1: Define Area of Interest

The area of interest is defined to be one where you need to drill, cut or gain information for a
variety of purposes. In order to make images, Conquest must acquire data over an area that is
predefined in geometry. The standard procedure is to collect data on a grid which is a fixed size.
The standard grids can be either metric or imperial units. 

The five grid sizes available are:

1. 24” x 24” or 600mm x 600mm

2. 48” x 48” or 1200mm x 1200mm 

3. 24” x 48” or 600mm x 1200mm 

4. 96” x 96” or 2400mm x 2400mm

5. 24” x 96” or 600mm x 2400mm

Details on setting the parameters for Grid Scans are described in Help > Grid Scan > Define
Parameters. 

Your specific site will dictate what is practical and where you can operate. Obviously in tight
corners and spaces you may not be able to lay out a grid and this could limit the utility of
Conquest in very confined spaces. In this case you may have to collect a partial grid or use Line
Scan mode only, which is discussed in the next section (Section 5.2: P22).

Before starting any work, you should obtain information about any construction practice that can
help in your evaluations of the Conquest results. Remember that construction plans and
drawings are just that; design plans! In construction, the implementation can deviate from plan.
Don’t be surprised when your Conquest results show some differences from your expectations.
This is a common occurrence.
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5.2 Step 2: Use Line Scan mode to get main structure orientation

Line Scan mode is used to help get a relative idea of what lies beneath before you start your
survey. The Conquest system allows you to acquire data along a straight line and examine the
information. From the principles of operation section (Section 4: P9), you will have a sense of the
information that you will see on the screen. Flat boundaries such as the bottom of the concrete
will appear as flat bands (Figure 4-9) whereas localized features such as rebar and conduits will
appear as inverted V’s (Figure 4-5).

Details on Line Scan mode are described in Help > Line Scan. 

Push the sensor along a straight line and you will see the concrete response scrolling on the
screen as you move. The data will scroll as fast as you move. It is best to go at a uniform slow
speed rather than going fast and jerky because irregular motion may reduce data quality. 

Line Scan data are saved to a maximum line length of approximately 6.4m (21 feet). If a Line
Scan is longer than this length only the last 6.4m (21 feet) is saved.

Backup Indicator: Line Scan mode incorporates a unique backup feature. Move the sensor
backwards and an arrow on the screen will appear over the collected data and keep moving to
the left of the screen as long as you are moving backward (see Figure 5-1). 

 Figure 5-1:Line Scan mode data display. Stopping and backing up displays a Rollback arrow that can be 
used to pinpoint the location of a target.

Move forward and the arrow moves forward. New data will not be collected until you reach the
point where you stopped and backed up. For example, if you pass a feature in the concrete,
simply roll the sensor back until the arrow appears exactly over it. The feature is located at the
center of the sensor. You can mark it off and continue data collection. 
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In Line Scan mode the objectives are: 

a) to confirm if the system is “seeing” into the concrete;

b) to obtain a sense of the site structure;

c) to assess the orientation of the rebar mats;

d) to get an idea of the depth of exploration.

In Line Scan mode you should identify the feature’s alignments. The purpose is to select the
optimum orientation for positioning the survey grid mat for imaging. 

Simple Line Scans don’t always provide a good sense of the spatial distribution of the features in
complex sites. Grid Scans permit you to create images to clearly define where objects are in
relation to one another, allowing for more efficient planning of cutting and drilling sites. 

5.3 Step 3: Place grid mat

Use Line Scan to determine the optimum orientation for grids. For the best resolution of targets,
the survey grid should be aligned perpendicular to any embedded objects in the concrete. If there
are features which run at oblique angles, you should select the predominant orientation for
aligning the grid.

When positioning the grid mat, you should pick a reference point and then place the grid mat
registration point on that mark. The best way to do that is to put a chalk mark or pin or other
indicator on the surface and then place the transparent grid mat over top of it. This reference
point should be such that you can go back to the site after you have removed the grid mat.

The transparent grid mat should be taped on to the structure with duct tape. During grid scan
collection, the Conquest sensor will be moved along the survey guide lines on the mat grid to
acquire the data.

Conquest comes with a standard 24” x 24” grid mats or the metric equivalent of 600mm x
600mm. This is the usual survey size for local area investigations. Larger areas can be surveyed
by taping multiple grid mats together to produce 24” x 48” grid (600mm x 1200mm), 48” x 48”
(1200mm x 1200mm) or 24” x 96” (600mm x 2400mm) grids. The 96” x 96” grid (2400mm x
2400mm) grids can also be done but the user must measure and mark this grid out. 

Details on setting the parameters for Grid Scans are described in Help > Grid Scan > Define
Parameters. 

On the Conquest transparent sheet grids, the line numbers which go on beyond the edge of the
first grid are indicated on the sheets in brackets. When joining multiple sheets, make the sheets
overlap them such that the sheet edges won’t catch the bottom of the sensor (see Figure 5-2)
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 Figure 5-2:Example of 4 Conquest Sheets taped down to make a layered grid.

The grids are labelled with numbers and letters. Survey lines which run up and down the sheet
are labelled 1, 2, 3, 4, 5, 6 and 7, whereas lines which run horizontally on the sheet are labelled
A, B, C, D, etc. These solid lines are spaced 4 inches or 100 mm apart and are used for normal
resolution surveys. Dotted lines are shown halfway between these lines and are used in addition
to the solid lines in high resolution surveys.

The lettering (alpha lines) and numbering (numeric lines) provides a grid coordinate system. This
same coordinate system shows up on the images created by Conquest for easy reference back
to the grid.

5.4 Step 4: Grid Scan Parameters

Once you have your grid mat in place, you are now ready to acquire Conquest data. To do this
you need to set up some parameters. 

Details on setting the parameters for Grid Scans are described in Help > Grid Scan > Define
Parameters. 

Make sure that the PCD option is set to the frequency appropriate for the geographic location, i.e.
60 Hz for North America and 50 Hz for Europe and Australia.

5.5 Step 5: Surveying on the Grid

Once you have established the parameters for the Grid Scan, you are ready to acquire data on
the survey grid mat. 

Details on Grid Scans are described in Help > Grid Scan > Scan the Grid. 
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5.6 Step 6: Calibrate the Concrete Type

The Concrete Type must be calibrated after Grid Scan collection to obtain clear depth slice
images and accurate depth estimates. Processing the data without determining the Concrete
may give a fuzzy image. It is instructive to try several values for the Concrete Type to see the
impact of not calibrating properly.

Details on determining the Concrete Type are described in Help > Grid Scan > Scan the Grid. 

5.7 Step 7: Depth Slice Image Computation

A key feature of Conquest is its ability to transform the raw sensor information into a series of
sliced images versus depth in the material. In general, depth slice images are generated after all
the lines in the grid have been collected, but images can also be generated when a partial grid
has been collected. This is useful when the grid area is smaller than the grid mat or when part of
the grid is obstructed so not all the lines can be collected.

Small grids can usually be processed in less than one minute. Larger grids may take several
minutes. 

Details on generating Depth Slice images are described in Help > Grid Scan > View the
Results. 

It is not necessary to reprocess data every time you want to view it. Once a grid has been
processed, the images are always immediately available by selecting Slice View from the main
menu or from the Grid Scan menu. 

Any time the Concrete Type changes, the grid scan data should be reprocessed as this value
affects image clarity and depth estimates.

While the GPR Depth Slice images are generated, the PCD data are processed to generate a
PCD image that is displayed in the Slice View menu. 

5.8 Step 8: Working with Depth Slice Images

Working with the maps generated by your Conquest system will help to increase your expertise,
knowledge base and proficiency. You may find it somewhat difficult initially to understand the
display if you are not used to viewing 3-D information. The display is designed to let you slice
through the concrete volume in 3 directions.
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 Figure 5-3:3D image of concrete as displayed by Conquest. The depth slice image is displayed in the 
upper left corner and represents the plan map view looking down on the grid scan area (see Figure 5-4). 

The images to the right and below the depth slice image are the Numeric and Alpha cross sectional views 
through the concrete defined by the cross-hairs on the depth slice. Conceptually, the cross-section views 

are like looking at the sides of the cube (see Figure 5-4). 

The best way to think of the depth slice images are as photograph-like views from above. The
rectangular regions to the bottom and the right should be thought of as cross sections through
the concrete in each direction at the positions of the cross-hairs (Figure 5-4).

 Figure 5-4:A conceptual Conquest Grid Scan image to understand the relationship between depth slice 
images, Alpha cross section images and Numeric cross section images.



Conquest 5-Line Scans and Grid Scans

27

One of the first things to note is the resolution of Conquest. Features will show up with a
minimum size of about 30 mm (1.5 inches). This is a fundamental limit of the transducer
response characteristics. You should not interpret a Conquest feature to be fully representative of
the dimension in the Depth Slice image. The object may be 1 inch in diameter or 1/8 of an inch in
diameter but it still will result in a 1.5 inch wide event on the depth slice image. You must be
careful about assigning size to features.

Step down through the depth slices and look for patterns. Normally regular patterns of rebar will
appear at different depths. Sometimes when a bar or conduit has a dip or a tilt, it will show up
partially at one depth and then show up at another depth more clearly as the bar or conduit cuts
down through the selected depth range. 

The display allows you to view any pair of cross section images on the sides of the 3D view. This
is very instructive because you can see both the lateral position and the depth as you learn how
to use the three views. 

Hyperbolic (inverted “V”) responses from crossing rebar perpendicularly are enhanced by turning
the Filter ON. The filter removes flat-lying reflectors in the cross section images. If your target is
flat-lying, like the bottom of concrete, make sure that the Filter is OFF.

The PCD image can also be displayed in the Slice View menu. The menu makes it easy to
toggle between the GPR Depth Slice images and the PCD image. Unlike depth slice images, the
PCD image is a single image that is NOT associated with a specific depth range.

Notice that, similar to GPR responses from rebar and other objects described above, the PCD
response are broad compared to the actual size of the cable so the width of the PCD response
has no relation on the size of the cable. 

Details on displaying Depth Slice images are described in Help > Slice View. 

5.9 Step 9: Interpretation of Results

You interpret the Conquest map results by looking for the dark areas on a light background or
light features on a dark background depending on the colour table. These areas indicate the
presence of an object in the subsurface at a particular depth. 

In general, you will find that bars, pipes and conduits make straight lines across the depth slice
whereas layers and horizons such as the bottom of concrete show up as uniform coloring which
is somewhat marbled across the area.

Experience is required in understanding the images that you obtain. It is fairly straightforward to
get a first order sense of a site by stepping Up and Down through the depth slices to understand
the observations. You can see what depth you are at by looking at the slider bars on the side of
the vertical cross sections. By looking at the cross sections you can get a sense of what features
are occurring at different depths whereas the depth slice gives you the spatial location of these
features.

See Section 7: P33 for some examples and interpretation. 
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5.10 Step 10: Marking the Site

You will need to view the depth slices up and down through the total depth range in order to mark
the site. The normal process is to step down through each depth and look for linear features
which usually indicate pipes and conduits. At each depth, mark the location of the feature on the
surface using the grid as a guide. You can mark directly onto the sheet with erasable marker.
Sensors & Software also have paper grids that can be placed on the site. (Call for availability).

Each linear feature or feature where there is a dark spot on the screen should be marked on to
the surface of the area. Marking the site will obviously be dictated by the site conditions. In an
open concrete structure at a construction area site you can use chalk or a crayon to mark the
surface. In finished floor areas one may want to use a washable marker or some other type of
easily removable indicator. You will no doubt need to adapt for your specific site condition.

5.11 Step 11: Transferring Data to a PC (Optional)

The Conquest systems offer the option of transferring data to a PC for further analysis. This is
available if you selected the enhanced system option or purchased the enhanced upgrade option
after buying the base system.

Details on Exporting data are described in Help > Tools. 

5.11.1 Compact Flash Drive Transfer

Files collected with the Conquest system are saved to an internal drive but the Export feature
copies data to an optional removable Compact Flash card. To transfer data copied to the
removable drive to a PC, ensure that Conquest is powered off. Then eject the compact flash
drive from the card slot under the Monitor Keypad (See Figure 2-6 on page 6) and insert it into a
user-supplied card reader connected to a PC. Use the Windows Explorer program to make a
new folder on the PC, read the removable drive and copy the data files to the new folder.

Each time Conquest data are exported to a compact flash disk, a new folder with an incrementing
number is created, i.e. EXPRT001, EXPRT002, etc. Grid Scan data are copied to the GRIDS
sub-folder, i.e. \EXPRT001\GRIDS and Line Scan data are copied to the LINES sub-folder, i.e.
\EXPRT001\LINES.

Since Conquest can collect up to 99 Grid Scans, each one is saved to a sub-folder with a number
corresponding to the grid number, i.e. CONQ001, CONQ002, etc. Therefore, grid scan data will
be found in folders with names like: \EXPRT001\GRIDS\CONQ001.
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5.11.2 PC Software

The Conquest Enhanced package has software for viewing and processing Conquest data on a
PC. The ConquestView software gives the same display as on the Conquest monitor. With
ConquestView, you can perform all of the display and process functions discussed here but have
the added benefit printing or exporting images to other software (for more details, see the
ConquestView User’s Guide). 

ConquestView exports Conquest data into a 3D format that can be viewed with 3D visualization
software like Voxler (available from Sensors & Software). 

5.11.3 Conquest Grid Parameter (.CV2) File Definition

To display a Conquest grid scan in ConquestView, the user must open the Conquest Grid
Parameter file. This file is saved in the same folder as the grid scan data and has a .CV2
extension. The name of the file is based on the following format:

MMDD_NNG.CV2

where MM is the month 01 – 12

DD is day 00 – 31

NN is grid number. Currently 01 – 99, and 00 for demo

G is the Grid size indicated by the following letters:

A = 2x2ft or 600x600mm 
B = 4x4ft or 1200x1200mm
C = 8x8ft or 2400x2400mm
D = 2x4ft or 600x1200mm 
E = 2x8ft or 600x2400mm 

For example, a 4x4 foot grid scan numbered 17 and collected on October 7 will have a Conquest
Grid Parameter file called 1007_17B.CV2
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 6 Help
Conquest has an extensive Help file built right into the system. Step-by-step details on all aspects
of Conquest including menu navigation, grid scans, slice views, line scans and system tools are
all available by selecting the Help menu option from the main menu Figure 6-1.

The Help screens are also available in Adobe Acrobat (PDF) and Microsoft PowerPoint (PPT)
format on the Conquest Software CD for easy reference.

 Figure 6-1:Accessing Help.
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 7 Examples & Interpretation
Due to space considerations, only the depth slices with discernible features are displayed for
each case study.

Case #1
This grid scan was conducted on the 5th floor of a medical building that was undergoing some
renovations. The grid size was 600x600mm, normal resolution.

In Figure 7-1a, we see rebar located between 60-90mm depth. If we go deeper to 240-270mm
(Figure 7-1b), there are two conduits running obliquely across the grid area. In the slice
immediately below that (Figure 7-1c), there are some features at numeric lines 4 & 6.

a) b)

c)
 Figure 7-1:
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Case #2

The scan was conducted at a test pad outdoors (Figure 7-2a & Figure 7-2b). The grid size was
1200x1200mm, normal resolution.

The main feature of this grid scan is the overlapping wire mesh, seen prominently at adjacent
depths. The reason that it shows at 2 different depths is that the mesh dips in certain areas, a
result of the weight of the concrete as it was being poured. From the pictures, it can be seen that
the mesh has a spacing of 200mm.

a)

b)

 Figure 7-2:
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Case #3

In Figure 7-3a) we see wire mesh again, with two conduits running at oblique angles to and
directly beneath the mesh. Figure 7-3b) shows the bottom of concrete between 9.6 to 10.8
inches deep. In this case, it is slab on pan which is a metal support sheet on which concrete was
poured during construction. The radar waves can not penetrate metal, and hence, the signals are
reflected entirely. 

a)

b)

 Figure 7-3:
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Case #4

In Figure 7-4a) we see a typical rebar pattern at a depth of 5-6 inches. The PCD image (Figure 7-
4b) reveals a strong magnetic field response that may be associated with the leftmost vertical
rebar. The interpretation is that a current-carrying cable has been tied to the rebar. 

a)

b)

 Figure 7-4:
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 8 Helpful Hints
8.1 Scan Speed and Data Quality

Conquest uses DynaQ, an advanced patented technology that adjusts data quality as the sensor
head movement speed varies. In most situations, moving the sensor head at a comfortable
speed generates data of good quality. In situations where target resolution or maximum
penetration depth is critical, moving slower increases data quality.

During Grid Scanning, the progress bar moves across the screen as the Conquest sensor head
is pushed along a grid line to indicate that data are being collected. With DynaQ, the colour of the
progress bar indicates the quality of the data at that point along the line:

Yellow = normal quality
Light blue = better quality
Dark Blue = highest quality

 Figure 8-1:With DynaQ, the colour of the progress bar indicates the quality of the data being collected. 
Dark blue, indicating the highest quality of data, is achieved by moving the sensor head more slowly com-

pared to the speed for the light blue or yellow colors.

In general, avoid collecting data at extremely high rates of speed. The microcomputers are
programmed to sense if the sensor head is moved too quickly. There are limits on the speed of
movement to ensure data quality. The system will “beep” to indicate if a data quality issue has
been detected. If this occurs, the operator is prompted to recollect the line.

8.2 Sensor Head Positioning

Proper positioning of the Sensor Head is very important for generating accurate depth slice
images. Before starting a line, use the arrows to ensure that the center of the Sensor Head is
correctly aligned on the start line on the grid mat.
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When collecting a grid scan, the sensor head has to be pushed slightly beyond (1-2cm) the end
line on the far edge of the grid mat before the survey line stops. 

If lines collected during Grid Scans seem to end before the end line on the far edge of grid mat is
reached, or they end more than 1 or 2 centimetres (1 inch) after the end line, recalibrate the
wheel odometer. An inaccurate odometer calibration value may result in poor data positioning
resulting in lines which are too long or too short. 

Verify that the grid size and measurement units selected in the Tools menu match the vinyl paper
grid mat being used. For example, Conquest comes with 24 inch imperial grids or 600 mm metric
grids that differ slightly in size. 

8.3 Collecting a Short Line or Partial Grid

To stop a Grid Scan line early, press the Enter button.

8.4 Line Scan Data File Length

Line Scan data are saved to a maximum line length of approximately 6.4 m (21 feet). The system
will beep to indicate the maximum length has been reached. If a Line Scan is longer than this
length only the last 6.4 m (21 feet) is saved.

8.5 Extending the Depth after Collecting Data

The system always scans to a depth of approximately 3 feet or 1 meter, regardless of the depth
setting the user has selected on the system.  The user depth setting only controls the depth of
data displayed on the screen.   The user can change the "Depth" menu item in Line Scan to see
deeper data.  To see deeper in Grid Scan mode, the user has to change the "Depth" setting for
the grid on the Grid Scan parameters menu.

8.6 Automatic Concrete Type Calibration

For the clearest images and most accurate depth estimates, it is important that the correct
Concrete Type value be used. In Grid Scan mode, Conquest automatically determines the
Concrete Type for Grid Scan by processing a combination of both the Alpha and Numeric lines.
However, lines should NOT be used for the Concrete Type calculation if they have any of the
following features: 

1. Very shallow targets.

2. Targets that are not crossed at a 90% angle; crossing at an angle will result in a
calibration value that is too high.

3. Data with no targets.

4. Complex data with multiple targets close together.

In these cases the user can force the system to determine the Concrete Type using only the
Alpha lines or the Numeric lines or even one specific, user-defined line. 
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To only use the Alpha Lines, move to the Slice View button and change Combo to Alpha and
then select the Slice View button to process the grid data and generate Depth Slice images. 

To only use the Numeric Lines, move to the Slice View button and change Combo to Num and
then select the Slice View button to process the grid data and generate Depth Slice images.

To use the Concrete Type from a specific line display the line in Grid Scan mode and select the
Concr Type button to determine the Concrete Type for that line. The concrete type value will
appear in the bottom right corner of the Concr Type button. Then, move to the Slice View button
and change Combo to User. Finally, select the Slice View button to process the grid data and
generate Depth Slice images.

Another way is to collect a Line Scan first to find a clean target, ensuring that the target has been
crossed perpendicularly, and determine the Concrete Type. Collect a grid scan in the usual way
and then use the user-defined Concrete Type option to adjust concrete type before generating
the depth slice images.

8.7 Image Enhancement Processing

The IEP feature automatically and continuously tests the system for proper calibration during
operation. If the system is ever found to be out of calibration, the user is immediately prompted to
run the System Test and re-calibrate. The IEP option ensures that Conquest always collects the
highest quality data and displays the most accurate images.

The IEP option is found in the Tools menu and is automatically enabled when Conquest is turned
on and is normally left on. In fact, if the IEP is turned off, the user is informed on all Line Scan,
Grid Scan and Depth Slice screens. As well, the next time that Conquest is turned on, the IEP will
be enabled.

There may be situations when the operator is constantly prompted to run the System Test
resulting in the inability to collect data (see System Test). In these cases, the IEP can be
temporarily turned off. If the IEP is disabled, allow the system to warm up for 5 minutes before
starting data collection. Even if data are collected without IEP, it can still be applied in the
ConquestView software after the data are transferred to a PC.

8.8 System Test

The System Test, accessed through the Tools menu, is run to ensure that all Conquest functions
are working properly and the system is properly calibrated. 

If the IEP option is enabled, as it usually is, the user is prompted to run the System Test if the
system detects that it is out of calibration.

There are several reasons why system requires the System Test:

1. Replacing hardware components like the sensor head or cable, 

2. Large changes in the surface materials in the scan area, for example a grid scan
partially collected on a metal plate on the surface.

3. Working in extremely variable temperature conditions.
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4. Operating in a temperature very different from the temperature that the System Test
was last performed in.

To perform the system test, follow the simple, on-screen instructions.

If constantly prompted to run the System Test, it may be necessary to turn the IEP feature off and
collect the data without it (see Image Enhancement Processing).

8.9 Odometer Wheel Calibration

The odometer wheel calibration is done under Wheel Cal in Tools. The odometer wheel should
be periodically calibrated, perhaps once a week or once a month. It should also be re-calibrated
if you are collecting data on a different surface than usual, for example, on a textured floor rather
than smooth concrete. Calibrating on long lines ensures the highest accuracy.
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 9 Troubleshooting
Conquest systems are designed to minimize user problems; however, all electronic devices are
subject to possible failure.  The following are troubleshooting hints if your Conquest fails to
operate or something wrong occurs:

9.1 Restart the System

The vast majority of problems can fixed by powering down the system, checking that all
connections are tightly secured (use a screwdriver, if necessary) and not damaged and then
powering back up again. 

Sometimes vibrations cause the cable connections to loosen just a bit and break contact and this
can cause errors.  Disconnecting cables and reconnecting them may provide a better contact
and solve the problem.  Turn the system back on and try running again.

If the power supply and cables are OK, the problem is likely a failure of the internal electronics.
Contact Sensors & Software Inc. (see Section 9.14: P44). 

9.2 Power Supply

The most common problem that can occur while trying to run a system is insufficient power. If the
system is being run from AC, there may be a problem with the AC power supply or adapter. If
using a DC power source with an AC inverter, the battery may be dead or have a low voltage. 

9.3 Warning Beep in Line Scan Mode

When collecting Line Scan data, if the system starts to ‘beep”, there are 2 possible causes:

1. The sensor head is being pushed too fast. This happens most often when the Stretch 
Factor is large. A high stretch value uses more computer resources for the screen 
display, slowing data acquisition. Reduce the Stretch value or simply slow down the 
speed of the Sensor Head to eliminate the warning.

If the beeping keeps occurring and you don’t think that you are moving too fast, check
the odometer calibration value and recalibrate if necessary.  An inaccurate odometer
calibration value may result in poor data positioning and/or acquisition of too much
data.

2. The sensor head has reached the maximum saved line length of about 6.4 metres (21
feet).  Continuing the Line Scan will result in the data overwriting the previously saved
data so that only the last 6.4 m (21 feet) of any Line Scan is saved.

9.4 Warning Beep and Flashing in Grid Scan Mode

When collecting Grid Scan data, if the system ‘beeps” and the current line number or letter
flashes, this means that the sensor head is being pushed too fast. When this occurs, the operator
is prompted to recollect the same line. To assure data quality, simply slow down the speed of the
sensor head.

If this error keeps occurring and you don’t think that you are moving too fast, check the wheel
odometer calibration value and recalibrate if necessary.  An inaccurate wheel odometer
calibration value may result in poor data positioning and/or acquisition of too much data.
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9.5 Sensor Head Key Pad Doesn't Respond

If the Sensor Head keypad does not respond, the usual cause is the sensor head being
unplugged from the cable during operation.  When the Sensor Head is reconnected, it will beep
and some of the keypad functions will start to work, but other functions will not.  The only solution
is to power down the system and restart it.

9.6 Remote Keypad Doesn't Work

If the remote keypad does not work:

1. Check the AAA batteries in the remote; they may be dead.

2. Check that the front of the remote keypad receiver is not obstructed by anything that
may interfere with signal from the remote keypad.

3. Check both ends of the cable connecting the remote keypad receiver to the control
module. 

9.7 System Does Not Start with the Sensor Head or Remote Keypads

The system doesn't recognize the presence of the remote or sensor head keypads unit after it
has been initialized. The user must press any key on the monitor keypad to start the system.

9.8 Nothing Displayed on Monitor

Sensor head beeps at start up but nothing appears on the display monitor:

1. Check the connections on the video cable on the control module.

2. Check both ends of the power cable that connects to the monitor; the plug on the
monitor end is removable and can occasionally pull out during transportation of the
system. 

9.9 Power Light on Monitor Keypad Not Illuminated

The system is plugged in, the monitor is on but there is no light on the monitor keypad:

1. Check both ends of the power cable that connects to the small AC/DC inverter; the 
plug on the inverter end is removable and can occasionally disconnect during 
transportation of the system. 

2. Check the connections between the AC/DC inverter and the control module at the
back of the Conquest system.

3. Flip up the monitor keypad panel and check that the multi-wire cable connection
between the control module and the monitor keypad is properly seated.

4. The LED may be faulty; press any keypad button to attempt to power up the system.
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9.10 Export Menu Item Not Accessible

The Export menu item under Tools will be greyed out and not accessible if:

1. No compact flash card is installed in the system when it starts up. The system should 
be powered down, the card installed and the system powered up again. Be aware that 
inserting a Compact Flash card with the system powered up can damage the card.

2. The card is not recognized by the system. Sensors & Software recommends the
Sandisk Extreme professional grade series Compact Flash cards. These cards are
widely available at consumer electronics stores.

3. The card is improperly formatted and is not recognized by the system. Try reformatting
the card and restarting the system. The flash card can only be formatted as FAT or
FAT16. Users running Windows 2000 or XP will have the additional options to format
as FAT32 and NTFS, both of which will not work with Conquest. If, after reformatting,
the card is still not recognized, a new card of the type recommended above should be
used.

4. The compact flash card does not have enough free memory space to accept all the
data in the Export folder. The system should be powered down, the card ejected, all
files removed from the card, the card re-installed, the system powered up, and Export
attempted again.

9.11 PCD Menu Item Not Accessible

The PCD menu item under Tools will be greyed out and not accessible if the Conquest sensor
head does not contain the PCD sensor. 

9.12 Constant Prompt to Perform System Test

If the operator is constantly prompted to run the System Test resulting in the inability to collect
data, turn off the IEP (Image Enhancement Processing) in the Tools menu. If the IEP is
disabled, allow the system to warm up for 5 minutes before starting data collection.

9.13 Creating a Test Line for Data Quality

One of the best ways of detecting problems with the Conquest system is compare data with data
collected previously along the same line. 

Soon after receiving the system and getting comfortable with its operation, collect a line of data at
a convenient, easily accessible location. The line does not have to be too long but 1-2 metres (3-
6 feet) is a good guide. This data line should be saved electronically and perhaps plotted out on
paper and dated. The test line could be collected say, every 6 months and, by reviewing the
previous data, system problems can be detected early. As well, if there is a suspected problem
with the system, this test line could be collected and compared with earlier tests. 
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9.14 Contacting Sensors & Software Inc.

If you develop problems with your Conquest system, contact your agent or Sensors & Software
Inc. 

Sensors & Software Inc.’s hours of operation are 9:00 AM to 5:00 PM Eastern Standard Time,
Monday to Friday. You can contact Sensors & Software Inc. at:

Sensors & Software Inc.
1040 Stacey Court

Mississauga, Ontario
Canada L4W 2X8

Tel: (905) 624-8909
Fax: (905) 624-9365

E-mail: sales@sensoft.ca

When contacting Sensors & Software Inc., please have the following information available:

1. System Serial Number. This is found by tilting up the Monitor Keypad.

2.) Version number of the data acquisition software.

3.The error number or message appearing.

4.A brief description of when the error is happening and the operating conditions
(temperature, humidity, sunshine, system and survey setup, etc.).
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 10 Care and Maintenance
10.1 Cable Care

Cables are designed to be as tough as practical.

Careless use of cables by making them carry loads for which they are not designed for can
cause internal damage.

Connectors are weak points in any system. With the use of this product in rough, dusty and
outdoor environments, users can minimize potential down time if they care for cables and treat
connectors with respect.

Cables and connectors are not designed to suspend, tow or otherwise carry the weight of
systems. They are part of the electrical circuit and should be treated accordingly. When not in use
they should be placed in their storage box. 

10.2 Conquest Sensor Head Wear Pad

The bottom of the Sensor Head is covered with a wear-resistant skid pad. The skid pad is
designed to take the majority of the abrasive wear. If the pad wears down enough, the less-
resistant plastic housing may start to wear. If this occurs, it is best to replace the skid pad. It is
easily removed and a new one can be purchased from Sensors & Software Inc.

10.3 Storage Cases

Equipment that is transported and stored loosely is more susceptible to damage. All equipment
should be stored in its shipping case or a storage box. Sensors & Software has shipping cases
available as options for all systems.

10.4 Spare Parts

Customers working in remote areas or if downtime in the field is unacceptable, should consider
buying spare parts like extra cables. 
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Appendix A:   Health & Safety Certification
Radio frequency electromagnetic fields may pose a health hazard when the fields are intense.  Normal
fields have been studied extensively over the past 30 years with no conclusive epidemiology relating elec-
tromagnetic fields to health problems.  Detailed discussions on the subject are contained in the references
and the web sites listed below.

The USA Federal Communication Commission (FCC) and Occupational Safety and Health Administration
(OSHA) both specify acceptable levels for electromagnetic fields. Similar power levels are mandated by
corresponding agencies in other countries. Maximum permissible exposures and time duration specified
by the FCC and OSHA vary with excitation frequency. The lowest threshold plane wave equivalent power
cited is 0.2 mW/cm2 for general population over the 30 to 300 MHz frequency band. All other applications
and frequencies have higher tolerances as shown in graphically in Figure A-A-1.

Figure A-1:  FCC limits for maximum permissible exposure (MPE) plane-wave equivalent power density mW/cm2.

All Sensors & Software Inc. pulseEKKO, Noggin and Conquest products are normally operated at least 1
m from the user and as such are classified as “mobile” devices according to the FCC.  Typical power den-
sity levels at a distance of 1 m or greater from any Sensors & Software Inc. product are less than 10-3 mW/
cm2 which are 200 to 10,000 times lower than mandated limits.  As such, Sensors & Software Inc. products
pose no health and safety risk when operated in the normal manner of intended use.



Appendix A: Health & Safety Certification Conquest

A-2

References

1. Questions and answers about biological effects and potential hazards of radio-frequency electromag-
netic field

USA Federal Communications Commission, Office of Engineering & Technology

OET Bulletin 56
(Contains many references and web sites)

2. Evaluation Compliance with FCC Guidelines for Human Exposure to Radio Frequency Electromag-
netic Fields.

USA Federal Communications Commission, Office of Engineering & Technology

OET Bulletin 56
(Contains many references and web sites)

3. USA Occupational Safety and Health Administration regulations paragraph 1910.67 and 1910.263.

Web Sites

www.fcc.gov/Bureau/EngineeringTechnlogy/Documents/bulletin 

www.osha-slc.gov/SLTC (see radio frequency)
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Appendix B: GPR Emissions, Interference and Regulations
All governments have regulations on the level of electromagnetic emissions that an electronic apparatus
can emit.  The objective is to assure that one apparatus or device does not interfere with any other appara-
tus or device in such a way as to make the other apparatus non-functional.  

Sensors & Software Inc. extensively test their pulseEKKO, Noggin and Conquest subsurface imaging
products using independent professional testing houses and comply with latest regulations of the USA,
Canada, European Community, and other major jurisdictions on the matter of emissions. 

GPR instruments are considered to be UWB (ultra wideband) devices.  The regulatory regimes worldwide
are devising new rules for UWB devices.  Sensors & Software Inc. maintains close contact with the regula-
tors to help guide standard development and assure that all products conform.  You should continually
monitor the "News" link on our website (www.sensoft.ca) for updates on standards. 

Electronic devices have not always been designed for proper immunity.  If a GPR instrument is placed in
close proximity to an electronic device, interference may occur.  While there have been no substantiated
reports of interference to date, if any unusual behavior is observed on nearby devices, test if the distur-
bance starts and stops when the GPR instrument is turned on and off.  If interference is confirmed, stop
using the GPR.  

Where specific jurisdictions have specific GPR guidelines, these are described below.
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B-1 FCC Regulations (USA)
This device complies with Part 15 of the USA Federal Communications Commission (FCC) Rules.  Opera-
tion in the USA is subject to the following two conditions:
(1) this device may not cause harmful interference and
(2) this device must accept any interference received, including interference that may cause undesired 

operation.

Part 15 – User Information
This equipment has been tested and found to comply with the limits for a Class A digital  device, where
applicable, and for an ultrawide bandwidth (UWB) device where applicable, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide reasonable protection against harmful interference when the
equipment is operated in a commercial environment. This equipment generates, uses and can radiate
radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause
harmful interference to radio communications. Operation of this equipment in a residential area is likely to
cause harmful interference in which case the user will be required to correct the interference at his own
expense.

WARNING
Changes or Modifications not expressly approved by Sensors & Software Inc. could void the user’s author-
ity to operate the equipment.

Certification of this equipment has been carried out using approved cables and peripheral devices.  The
use of non-approved or modified cables and peripheral devices constitutes a Change or Modification out-
lined in the warning above.

Operating Restrictions
Operation of this device is limited to purposes associated with law enforcement, fire fighting, emergency
rescue, scientific research, commercial mining, or construction. Parties operating this equipment must be
eligible for licensing under the provisions of Part 90 of this chapter. 

FCC Interpretation of Operation Restrictions issued July 12, 2002
(FCC Order DA02-1658, paragraph 9)

The regulations contain restrictions on the parties that are eligible to operate imaging systems. 1  Under the
new regulations, GPRs and wall imaging systems may be used only by law enforcement, fire and emer-
gency rescue organizations, by scientific research institutes, by commercial mining companies, and by
construction companies.  Since the adoption of the Order, we have received several inquiries from the
operators of GPRs and wall imaging systems noting that these devices often are not operated by the users
listed in the regulations but are operated under contract by personnel specifically trained in the operation of
these devices.  We do not believe that the recent adoption of the UWB rules should disrupt the critical
safety services that can be performed effectively only through the use of GPRs and wall imaging systems.
We viewed these operating restrictions in the broadest of terms.  For example, we believe that the limita-
tion on the use of GPRs and wall imaging systems by construction companies encompasses the inspec-
tion of buildings, roadways, bridges and runways even if the inspection finds no damage to the structure

1.    See 47 C.F.R. §§15.509(b), 15.511(b), and 15.513(b)
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and construction does not actually result from the inspection; the intended purpose of the operation of the
UWB device is to determine if construction is required.  We also believe that the GPRs and wall imaging
systems may be operated for one of the purposes described in the regulations but need not be operated
directly by one of the described parties.  For example, a GPR may be operated by a private company
investigating forensic evidence for a local police department.  

FCC Permitted Mode of Usage
The GPR antenna must be kept on the surface to be in compliance with FCC regulations.  Use of the
antenna is not permitted if it is lifted off the surface.  Use as a through-the-wall imaging device is prohib-
ited.  

GPR Use Coordination
FCC regulation 15.525(c) (updated in February 2007) requires users of GPR equipment to coordinate the
use of their GPR equipment as described below: 

TITLE 47--TELECOMMUNICATION 

CHAPTER I--FEDERAL COMMUNICATIONS COMMISSION

PART 15_RADIO FREQUENCY DEVICES

Subpart F_Ultra-Wideband Operation Sec.

15.525  Coordination requirements.

    (a) UWB imaging systems require coordination through the FCC before the equipment may be used.
The operator shall comply with any constraints on equipment usage resulting from this coordination.

    (b) The users of UWB imaging devices shall supply operational areas to the FCC Office of Engineering
and Technology, which shall coordinate this information with the Federal Government through the National
Telecommunications and Information Administration. The information provided by the UWB operator shall
include the name, address and other pertinent contact information of the user, the desired geographical
area(s) of operation, and the FCC ID number and other nomenclature of the UWB device. If the imaging
device is intended to be used for mobile applications, the geographical area(s) of operation may be the
state(s) or county(ies) in which the equipment will be operated. The operator of an imaging system used
for fixed operation shall supply a specific geographical location or the address at which the equipment will
be operated. This material shall be submitted to:

 Frequency Coordination Branch, OET 
Federal Communications Commission 
445 12th Street, SW, Washington, D.C. 
20554 
Attn: UWB Coordination

(Sensors & Software Inc. Note: The form given on the following page is a suggested format for performing
the coordination.)

    (c) The manufacturers, or their authorized sales agents, must inform purchasers and users of their sys-
tems of the requirement to undertake detailed coordination of operational areas with the FCC prior to the
equipment being operated.

    (d) Users of authorized, coordinated UWB systems may transfer them to other qualified users and to dif-
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ferent locations upon coordination of change of ownership or location to the FCC and coordination with
existing authorized operations.

    (e) The FCC/NTIA coordination report shall identify those geographical areas within which the operation
of an imaging system requires additional coordination or within which the operation of an imaging system
is prohibited. If additional coordination is required for operation within specific geographical areas, a local
coordination contact will be provided. Except for operation within these designated areas, once the infor-
mation requested on the UWB imaging system is submitted to the FCC no additional coordination with the
FCC is required provided the reported areas of operation do not change. If the area of operation changes,
updated information shall be submitted to the FCC following the procedure in paragraph (b) of this section.

    (f) The coordination of routine UWB operations shall not take longer than 15 business days from the
receipt of the coordination request by NTIA. Special temporary operations may be handled with an expe-
dited turn-around time when circumstances warrant. The operation of UWB systems in emergency situa-
tions involving the safety of life or property may occur without coordination provided a notification
procedure, similar to that contained in Sec.  2.405(a) through (e) of this chapter, is followed by the UWB
equipment user.[67 FR 34856, May 16, 2002, as amended at 68 FR 19751, Apr. 22, 2003]

    Effective Date Note: At 68 FR 19751, Apr. 22, 2003, Sec.  15.525 was amended by revising[[Page
925]]paragraphs (b) and (e). This amendment contains information collection and recordkeeping require-
ments and will not become effective until approval has been given by the Office of Management and Bud-
get.

The form given on the following page is a suggested format for performing the coordination.
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FCC GROUND PENETRATING RADAR COORDINATION NOTICE

 NAME:

ADDRESS:

CONTACT INFORMATION [CONTACT NAME AND PHONE NUMBER]:

AREA OF OPERATION [COUNTIES, STATES OR LARGER AREAS]:

FCC ID: [E.G. QJQ-CONQ-DE1]

EQUIPMENT NOMENCLATURE: [E.G. CONQUEST DE] 

Send the information to:

Frequency Coordination Branch., OET
Federal Communications Commission
445 12th Street, SW
Washington, D.C.  20554
ATTN:  UWB Coordination
Fax:       202-418-1944

INFORMATION PROVIDED IS DEEMED CONFIDENTIAL
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B-2 ETSI Regulations for the EC (European Community)
In the European Community (EC), GPR instruments must conform to ETSI (European Technical Standards
Institute) standard EN 302 066-1 v1.2.1.  Details on individual country requirements for licensing are coor-
dinated with this standard.  For more information, contact Sensors & Software’s technical staff.

All Sensors & Software ground penetrating radar (GPR) products offered for sale in European Community
countries or countries adhering to ETSI standards are tested to comply with EN 302 066 v1.2.1.

For those who wish to get more detailed information, they should acquire copies of the following docu-
ments available from ETSI.

ETSI EN 302 066-1 V1.2.1 (February 2008) Electromagnetic compatibility and Radio spectrum Matters
(ERM); Ground and Wall- Probing Radar applications (GPR/WPR) imaging systems; Part 1: Technical
characteristics and test methods

ETSI EN 302 066-2 V1.2.1 (February 2008) Electromagnetic compatibility and Radio spectrum Matters
(ERM); Ground and Wall- Probing Radar applications (GPR/WPR) imaging systems; Part 2: Harmonized
EN covering  essential requirements of article 3.2 of the R&TTE Directive

ETSI TR 101 994-2 V1.1.2 (March 2008) Electromagnetic compatibility and Radio spectrum Matters
(ERM); Short Range Devices (SRD); Technical characteristics for SRD equipment using Ultra Wide Band
technology (UWB); Part 2: Ground- and Wall- Probing Radar applications; System Reference Document
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B-3 Industry Canada Regulations 
Industry Canada published it regulations for ground penetrating radar (GPR) on Mar 29 2009 as part of the
RSS-220  titled  'Devices Using Ultra-Wideband (UWB) Technology'.

Industry Canada has made a unique exception for GPR by not requiring user licensing.  The user does
have to comply with the following directives:

(1) This Ground Penetrating Radar Device shall be operated only when in contact with or within 
1 m of the ground.

(2) This Ground Penetrating Radar Device shall be operated only by law enforcement agencies, 
scientific research institutes, commercial mining companies, construction companies, and 
emergency rescue or firefighting organizations.

Should the ground penetrating radar be used in a wall-penetrating mode then the following restriction
should be noted by the user:

(1)  This In-wall Radar Imaging Device shall be operated where the device is directed at the wall 
and in contact with or within 20 cm of the wall surface.

(2) This In-wall Radar Imaging Device shall be operated only by law enforcement agencies, sci-
entific research institutes, commercial mining companies, construction companies, and emer-
gency rescue or firefighting organizations.

Since operation of GPR is on a licence-exempt basis, the user must accept the following:

Operation is subject to the following two conditions: (1) this device may not cause interference, and (2) this
device must accept any interference, including interference that may cause undesired operation of the
device. 
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Appendix C: Instrument Compatibility
Immunity regulations place the onus on instrument/apparatus/device manufacturers to assure that extra-
neous interference will not unduly cause an instrument/apparatus/device to stop functioning or to function
in a faulty manner.

Based on independent testing house measurements, Sensors & Software Inc. systems comply with such
regulations in Canada, USA, European Community and most other jurisdictions. GPR devices can sense
electromagnetic fields.  External sources of electromagnetic fields such as TV stations, radio stations and
cell phones, can cause signals detectable by a GPR which may degrade the quality of the data that a GPR
device records and displays.

Such additive signal is unavoidable but sensible survey practice and operation by an experienced GPR
practitioner can minimize such problems. In some geographic areas emissions from external sources may
be so large as to preclude useful measurements. Such conditions are readily recognized and accepted by
the professional geophysical community as a fundamental limitation of geophysical survey practice.  Such
interference being present in the GPR recordings is not considered as an equipment fault or as a failure to
comply with immunity regulations.  
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Appendix D: Safety Around Explosive Devices

Concerns are expressed from time to time on the hazard of GPR products being used near blasting caps
and unexploded ordnance (UXO). Experience with blasting caps indicates that the power of Sensors &
Software Inc.’s GPR products are not sufficient to trigger blasting caps. Based on a conservative indepen-
dent testing house analysis, we recommend keeping the GPR transmitters at least 5 feet (2m) from blast-
ing cap leads as a precaution.  Some customers do experimental trials with their particular blasting devices
to confirm with safety.  We strongly recommend that GPR users routinely working with explosive devices
develop a systematic safety methodology in their work areas.  

The UXO issue is more complex and standards on fuses do not exist for obvious reasons. To date, no
problems have been reported with any geophysical instrument used for UXO. Since proximity and vibration
are also critical for UXO, the best advice is to be cautious and understand the risks.
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Appendix E: Conquest Glossary
Conquest is used to scan concrete.  There are two types of scans - grid scans and line scans.  

Scan: the act of acquiring Conquest data.

Grid Scan: is the word to describe the process of acquiring Conquest data on a grid over an
area with the end goal being to create depth slice images.

Line Scan: is the term to describe collecting data along one or more lines for immediate site
assessment using cross-section images.  A series of line scans helps define site
conditioning prior to a grid scan.  

Grid: is the term describing a square or rectilinear set of straight lines which cover an
area.  Acquiring data on a grid means acquiring Conquest data along each line
forming the grid.  Acquiring data on a grid is a pre-requisite for creating depth
slice images.  Often the grid is pre-marked on a grid mat which is also referred to
as a grid.  

Line: is the term used to identify the position for Conquest data acquisition.  A line is
normally straight and Conquest records position from the start to the end of the
line using its odometer wheel.  

Scan Depth: is the term which describes the user selected maximum depth for the Conquest
display.  

Depth Slice: is the term to describe the Conquest data acquired between two depths - top  of
depth slice and bottom of depth slice.  Most often a grid scan has the scan depth
subdivided into a number of depth slices.  

Slice or Depth 
Slice Image: is the term used to describe the Conquest data in a depth slice when the data are

displayed as a computer generated image.  This term will normally be shortened
to slice.  

MultiSlice or 
MultiSlice View: is the term used when displaying a number of contiguous depth slice images

which, when viewed together, enable the user to view a complete volume
described by the grid area and the scan depth.  

Grid Size: term used to depth area extend of a grid (i.e. 24" x 24", 600 mm x 600 mm, 600
mm x 2400 mm, etc.).

Grid Resolution: is the term used to describe the spatial definition attained in a depth slice image
and is controlled by the line spacing is a grid.  Conquest grids have normal and
high resolution options.  

Concrete type: is the term used to characterize the speed that Conquest signals travel in the
concrete.  Concrete type is automatically estimated by the Conquest system.
Concrete type is a critical parameter when creating depth slice images and esti-
mating depths of targets in concrete.

Color Palette: is the term used to refer to the color palette or color table used in the creation of
depth slice images or Conquest cross-section views.  
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Grid Scan Number: is the identifier for the data and images associated with a grid scan.  Conquest
stores scanned data and identifies each scanned data set by its scan number.  

Line Scan Number: is the identifier for data saved when carrying out a line scan.  

Gain: Since Conquest signals are strong for shallow targets and weaker for deeper tar-
gets, when displaying Conquest cross sections, a control is needed so shallow
targets can be viewed at the same strength as deeper targets.  Gain acts like an
audio volume control.  

Drill Locator: is a device used to select an area in a Conquest image volume that is clear of
any embedded structures.  The dynamic drill locator allows the user to select
areas with the least likelihood of hitting an embedded structure when drilling or
cutting.  

Section or 
Cross-Section Image: the term used when Conquest line scan data are displayed as a computer gener-

ated image (showing depth versus position along the line).  Quite often the term
is shortened to cross-section or section.

Horizontal Stretch: is the term used to describe stretching the horizontal (position) axis of a cross-
section image.  

Slice Type: standard Conquest grids have numerical line names in one direction and alpha-
betical line names in the other direction.  Conquest depth slice images can be
formed from numeric, alpha, or combined numeric and alpha (combo).  Combo
slices are the standard but sometimes advanced users can benefit from viewing
alternate slice types.

Numeric Slice: depth slice image created from numerically named lines in a Conquest grid scan.

Alpha Slice: depth slice image created from alphabetically named lines in a Conquest grid
scan.

Combo Slice: depth slice image created from combining both numerically and alphabetically
named lines in a Conquest grid scan.  

Self-Test: refers to the action of the Conquest unit carrying out a series of tests automati-
cally which determines the proper operation of the unit.  Actions such as power
level checks, timing checks, indicator checks, etc. are taken and diagnostics dis-
played or archived.  Current Conquest performs self-tests referred as Short Test
and Long Test. 

Wheel Odometer 
Calibration: the processing of calibrating the odometer wheel sensor to assure accurate dis-

tance measurement. Sometimes shortened to Wheel Cal or Odometer Cal. 

Sensor or 
Sensor Head: the unit moved over the surface used for sensing the subsurface.  

Display Unit: the shipping and storage box which contains the display monitor and the control
electronics module, distributes power and provides sensor storage.  

Keypad: the units used to control Conquest operation using up, down, left, right, enter and
star keys.



Conquest Appendix E: Conquest Glossary

E-3

Monitor: the display panel mounted inside the display unit.

Control Electronics
Module: module mounted inside the display unit which holds electronic control circuits,

distributes signals and houses the removable flash memory.  

Remote Keypad: the wireless keypad which enables operation of Conquest from a distance.  

Remote Keypad 
Receiver: the infrared receiver that detects commands from the remote keypad. 

Sensor Keypad: keypad mounted on the sensor.

Monitor Keypad: keypad mounted below the display monitor in the display unit.  

Grid Mat: plastic or paper sheet with grid lines pre-marked to enable grid scans.  Often the
name is shortened to just grid or mat.  

Selector: the highlight box that appears around the current selected menu item.

Slide: name of an image in the Conquest "Help" section.

Slide Show: term applied to the process of automatically displaying Conquest "Help" slides
with a timed delay.

Color Bar: the bar of colors which display the colour palette on the Conquest "Color" menu
items. Colors to the left represent strong, negative signals and colors to the right
indicate strong, positive signals. Colors in the middle represent weak signals. 

3D View: the term used in Conquest where depth slices and cross-sections are displayed
simultaneously to show a 3D display on flat display. 

PCD - Power 
Cable Detector: device within the Conquest sensor head for measuring the magnetic field inten-

sity produced by power lines carrying electric current at the power line frequency. 

PCD Image: plan view display of PCD amplitude.

PCD Profile: plot of PCD amplitude variation along a line.

PCD Amplitude: intensity of magnetic field detected.

PCD Frequency: power cable detector fundamental frequency selectable by user (e.g. 60 Hz in
North America, 50 Hz in Europe/Australia)

DynaQ: a technology that adjusts Conquest data quality as the sensor head movement
speed varies.
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